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1. OVERVIEW 
The MyCoins-UK app was developed to catalogue a substantial collection of British coins (over 950 
separate items). However, a variant of MyCoins can be used for coins from anywhere. See section 
9 below for details of the MyCoins-World app. For most purposes, this User Guide can be used for 
both apps.  A supporting document "MyCoins-World Addendum" is available to give details of the 
differences between MyCoins-UK and MyCoins-World. 
 
The primary database is a text file in CSV format which can be opened in a spreadsheet app such 
as Excel, Numbers or LibreOffice/OpenOffice. 
 
Each item in the collection can be a single coin or a set of coins. An item can have two primary 
pictures, the obverse/front and the reverse/back of an item. In addition, an item can have any 
number of other images associated with it. For example, a set of coins may have additional sheets 
of information as part of the set; these can be included as additional images. All images are kept in 
a separate folder linked to the relevant items by the name of the image files. 
 
Where practical, the app uses picking lists rather than free text input. The following picking lists 
are provided: 
 

• Bullion.csv – approximate Bullion rates 

• Conditions – commonly used terms to describe the condition of a coin 

• Denominations – denominations of the coins 

• Materials, – the materials that coins are made of 

• Monarchs, – a list of British Monarchs with the period they reigned 

• Set codes, – terms used to group items into sets 
 
A coin collection consists of a folder with various files and sub-folders, for example a collection 
called "My-British-Coins" would appear as follows 
 
  [Collection-My-British-Coins] 
   Collection.csv – main database itself 
   [Images] – coin images related to the main database 
   [Lookups] – picking lists 
 
If you want to keep a full backup of your coin collection, you should save the complete folder, not 
just the main file "Collection.csv". 
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2. GETTING STARTED 
2.1 What's Where 

MyCoins-UK consists of 2 main screens and 2 support screens: 
 

Coin List 
Screen: 

 

 

 

Coin Details 
Screen: 

 

 
  



© 2018 Peter Reid MyCoins-UK/World v0.7, August 2018 Page 5 of 33 

 

Valuations 
Screen: 

 

 

 

Calibration 
Screen: 
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2.2 Coin List Screen 

The Coin List screen is the main screen for listing some or all of your coins and for searching: 
 

 
 

1. Search Filters – selected fields can be used as search filters. If more than 1 field is used at 
the same time, they are combined using AND (all terms must be true) or OR (any single 
term must be true) – see (4) 

2. Images? – must coins have images (Yes), mustn't have images (No), or don't mind (Any) 

3. Gone? – has the item been disposed of, i.e. no longer in the collection 

4. Combine terms – how should search conditions/terms be combined – using AND (all terms 
must be true) or OR (any single term must be true) 

5. Search – start searching based on filters etc. on this screen – see section 2.7 below 

6. Advanced… – display pop-up for advanced search criteria to be used instead of search 
filters on this screen – see section 4 below 

7. List of results – where the results of a basic filter search or an advanced search will be 
shown – see section 4 below 

8. Display Selected/All – display the details for all the results listed or only those that have 
been selected from the list of results 

9. Add New Item – add a new coin or set to the collection – see section 3.1 below 

10. Delete Selected – delete 1 or more items from collection (note that the primary info is 
permanently deleted but 'deleted' images are preserved, starting with 'X~' just in case you 
wish to re-use them elsewhere) 

11. Compare Images – the images for 2 or more items are opened and displayed using the 
default image viewer/editor for your system 
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2.3 Coin Details Screen 

The Coin Details screen is where you'll see all the details, including images for an individual coin or 
set of coins: 
 

 
 

1. Pick lists – common terms are available in pick lists 

2. Year – the year plays a key role in the content of other fields – see section 3.3 below 

3. Diameter – used to display coin images at real size – see section 2.5 below 

4. Weight – used to calculate approximate bullion value 

5. Bullion – uses table in CSV lookup file for current bullion rates – see section 11.3 below 

6. Notes – these can be scrolled to enter more extensive information 

7. obverse image – displayed at real size where possible 

8. reverse image – displayed at real size where possible 

9. other images – multiple images for sets, info sheets etc. 

10. navigation buttons – used to move or jump between items selected in the list screen 

11. coin creation buttons – facilities for item creation and deletion 
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2.4 Valuations Screen 

The Valuations screen is where you'll be able to calculate the approximate value for a subset of 
items in your collection. The valuations can include or exclude any Bullion values: 
 

 
 

1. Bullion Rates table – current prices for Bullion, editable details are in the Bullion.csv 
lookup file – see section 11.3 below 

2. Valuation Criteria – how values are to be calculated: 

a. Including Bullion Values – if there is a Bullion value and it is higher than the related 
Value, the Bullion value will be used instead of the Value 

b. Excluding Bullion Values – only the Value column is used 

c. Bullion Values Only – other value and price columns are ignored 

3. Valuation – the result of the valuation 

4. Items List – a sortable table of the items valued 

Note that the Bullion rates you use should be from a reliable source and updated as and when 
necessary.  Also, the valuations should be considered as approximate, for guidance only, they do 
not imply the actual values for insurance or for sale. 
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2.5 Calibration Screen 

MyCoins-UK will try to display the image of a coin at its real size.  However, in order to do this, the 
app needs to know the width/diameter of a reference/sample image displayed on the calibration 
screen. 
 

 
 

1. Sample image – this should be exactly 38mm or 1.5in in diameter 

2. Actual size – this is the actual size displayed in mm or inches 

3. Calibrate – set the calibration factor for the current session 

The calibration screen appears at the start of every session of MyCoins-UK.  If you want the app to 
remember your measurement, you should record it in the app's INI file – see section 11.2.1 below. 
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2.6 Working with Coin Lists 

The table on the Coin List screen is populated with item entries as a result of a filter search or an 
advanced search. You can opt to display the details of all items in the list or you can limit the 
details viewed to those items that are selected. 
 
In the sample screen below you can see that 23 items are listed and 3 of these have been selected: 
 

 
 
The 2 display buttons allow you to see the details for all 23 items or just the 3 selected items. 
 
The Reset Selections button removes the highlighting from the 3 selected items, but they will 
remain in the list of 23 items.  Note that the Reset button towards the top right of the screen 
resets the search results, causing the list to be populated with all items in the collection. 
 
Items in the list can be selected/de-selected as usual: 
 

• click – select 

• click again – de-select 

• click top, shift-click bottom – select a group 

• click bottom, shift-click top – select a group 
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2.7 Searching 

MyCoins-UK provides 2 search facilities, both of which are used to populate the table of coin items 
on the Coin List screen.  These facilities are: 
 

• filtered searching – described in this section 

• advanced searching – described in section 4 below 
 
The search filters are towards the top of the Coin List screen: 
 

 
 
You can combine terms in the filter fields together with image and disposal requirement. 
 
The filter fields are first: 
 

 
 
Simply enter text in any of the filter fields, partial matches, both upper and lower case will be 
found, e.g. "geo" in the Monarch filter field will match against George V, George IV, George III, etc. 
 
Then there is the image presence control: 
 

 
 
If you want to see items that have images, simply select Yes for images. Selecting No means the 
items do not have images at present. Selecting Any means that items will be a match based on the 
other criteria specified, the presence or absence of images will not affect the search results. 
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Followed by the disposal control: 
 

 
 
Selecting Yes means the item is no longer in the collection, it has been disposed of. Selecting No 
means the item has not left the collection, and selecting Either means the item may or may not 
still be in the collection. 
 
Finally there's the combining operator control: 
 

 
 
The Combine control determines how search conditions/terms should be combined: 
 

• using AND – all search terms must be true 

• using OR – any single search term must be true 
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3. EXPLORING THE DETAILS 
3.1 Adding New Coins or Sets 

New coins may be added from either the Coin List screen or the Coin Details screen: 
 
List screen:  Details screen: 

 
 

 
Having triggered the New option you'll see the Coin Details screen with all the fields empty to 
begin with. Simply enter details for each of the fields as required. 
 

 
 
Note that the combination of denomination and year of a coin generates content in linked fields 
(see section 3.3 below).  For this reason, it's best that you enter the denomination and year before 
adding additional information. 
 
The Notes field box can be expanded to make it easier to enter more extensive information. 
 

3.2 Details Navigation 

MyCoins-UK has a standard set of navigation controls for moving to the first, previous, next and 
last item being displayed in the Coin Details screen: 
 

 
 
Clicking the numbers in the middle allows you to jump to any item in the current set of details. 
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3.3 Linked Fields 

Some fields in the coin details are linked.  In particular, the following links exist: 
 

• Denomination + Year – generates: Diameter, Material and Weight 

• Weight + Material – generates: Bullion 

• Diameter – controls the size of a coin's Obverse and Reverse images 
 
Where possible you should enter the details in the controlling fields before entering dependent 
fields content. Note that the Resync Years… option in the Edit menu will work through the 
selection of coins in the details screen touching the Year field to make it resync with its linked 
fields – see section 6 below.  For example, you might need to resync because of a series of 
corrections or additions to some of the lookup tables/files. 
 

3.4 Coin Images 

3.4.1 Types of Coin Image 
MyCoins-UK supports 3 types of coin images: 
 

• Obverse or Head side – coins are displayed at real size1, sets are sized to fit available space 

• Reverse side – coins are displayed at real size, sets are sized to fit available space 

• Others – any other images such as set cases, info sheets, etc. 
 
Clicking the Obverse, Reverse or Other buttons will prompt for a new or replacement image to be 
linked to the current coin.  Shift-clicking these buttons will remove the relevant image. 
 

 
 
Note that if you have more than one Other image, you must add or remove all of them at the 
same time.  Click the left/right arrows to view all the Other images. 
  

                                                      
1 Obviously, the real size will be used only if the image is cropped as close as possible to the coin's outline. 
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3.4.2 Getting In Close 
Any image can be expanded to fill MyCoins-UK's details screen temporarily, simply click the image 
to see an expanded copy and double-click the expanded image (or click the close button as usual) 
to hide it again: 
 

 
 
You can move and resize the expanded image in its own window to see the detail of the coin etc.: 
 

 
 
Double-clicking the zoomed image will close the image window. 
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3.4.3 Editing The Images 
If you shift-click the expanded image it will be opened inside your default image viewer/editor 
(such as Preview on the Mac).  Having made any changes using the default viewer/editor, save the 
changes and return to MyCoins-UK. In MyCoins-UK click the Reload Images button to have the 
revised images linked to the current coin. 
 

 
 
Note that coin images are stored in a separate Images folder and that images are dynamically 
linked to coins based on their file names.  For example, the above image for the 1996 £5 coin 
reverse side will be named as follows: 
 
 10647~1996~Five Pounds~rev.jpg 
 
where the parts of the name are derived as follows: 
 
 10647 is the Unique ID 
  1996 is the Year 
   Five Pounds is the Denomination 
    rev is the side (obv, rev or oth) 
Other images are named: 

…oth~a.jpg 
…oth~b.jpg 
…oth~c.jpg 
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3.4.4 Image Size and Quality 
Optimising images often requires a balancing act between image quality and overall file size. Given 
that you may have hundreds of images, file size may become important and you might be 
surprised just how much storage capacity might be required.  For example, a recent collection with 
40 items having supporting images required about 160 separate image files, averaging 6-7MB per 
image and required just over 1GB (i.e. 1,000MB) of file storage!  Reducing the image file sizes by 
adjusting the number of pixels and the pixels resolution reduced each image to an average 1.2MB 
in size, reducing the storage requirement to 189MB, quite a difference. 
 
We recommend that your original images should be as high quality and size as possible and that 
you generate reduced size copies for use with MyCoins-UK.   For example, we took the following 
image on a 18 megapixel camera (a Panasonic DMC-TZ60 Camera): 
 

  

original image 6.3MB, 3464x3470px, 180dpi adjusted image: 1.3MB, 1249x1247px, 96dpi 
 
The images were adjusted using a standard graphics tool (e.g. Preview on the Mac): 
 

 

 

• adjusted exposure (increased) 
 
 

• adjusted shadows (significantly increased) 

 

 

 

• white-point adjustment (dropper tool) 
 
 
 

• sharpness adjustment 

 
Note that the image adjustments not only reduced the storage requirement, they also made 
MyCoins-UK run faster.  In particular, moving between items with images became a lot quicker. 
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3.4.5 Comparing Images 
Sometimes it is helpful to compare similar coins, especially when deciding on the condition of a 
coin. In general, MyCoins-UK provides views of images for a single coin at a time where you can 
see an enlarged view of a single image for a coin.  The app provides an alternative method for 
viewing multiple coin images at the same time – the Coin List screen has a Compare Images button 
to open up the Obverse, Reverse or Other images for the selected items in the list: 
 

 
 

1. Select images for comparison – select 2 or more items for comparison 

2. Compare Images – start the comparison 

3. Choose image type – choose the type of images to compare 

The images are not opened by MyCoins-UK, they're displayed by your default image viewer/editor: 
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4. ADVANCED SEARCHING 
 

In addition to filtered searching MyCoins-UK provides an advanced search facility which can be used 
instead. Open the Advanced Search pop-up by clicking the Advanced… button on the coin list screen: 
 

 
 
The advanced search features are available in a pop-up that appears over the list screen: 
 

 
 

1. Field/Column selector – select the field of interest 

2. Logical Operator selector – select comparison required (e.g. equals/ not equals, etc.) 

3. Value selector – the value you want 

4. List of criteria – list of criteria to be matched 

5. Images? – must coins have images (Yes), mustn't have images (No), or either (Any) 

6. Combine terms – how should search criteria be combined – using AND (all terms must be 
true) or OR (any single term must be true) 

7. Search – start searching based on the requirements on this screen 

8. Delete – delete selected criteria 

9. Reposition – 3 buttons that move the pop-up to the top, middle or bottom of the screen to 
enable you to see the underlying list screen 

10. Special "TEXT" – a selection of TEXT from a dropdown list means that a fuzzy text search is 
required, not an exact match to fixed picking list values – Text box contains required text 

1 
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An advanced search consists of one or more search criteria, where each criterion is a combination 
of a field and a value that must satisfy a condition.  For example, in the following advanced search 
we want to list (and display) any coins that satisfy the requirements: 
 

the coin is a Crown OR Halfcrown and it doesn't matter whether they have images 
 

 
 

1. it's a Crown – the Denomination equals (=) Crown 

2. it's a Halfcrown – the Denomination equals (=) Halfcrown 

3. Either OR both – use OR to combine 1. and 2. 

4. Don't care about images – Any for images 

5. Search – start searching 

 
The list of Logical Operators is as follows: 
 

• = – equal to 

• <> – not equal to 

• <= – less than or equal to, or "before" 

• >= – greater than or equal to, or "after" 

• is empty – the field is empty 

• is not empty – the field has something in it 

• contains – the field has specific text anywhere in it 

• doesn't contain – the field doesn't contain specified text anywhere 
 
Note that you can change a rule by selecting it before making the required changes. 
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5. BULK FIND & REPLACE 
 
Sometimes you may want to make the same change to a number of coins.  This is where the Find 
& Replace facility is of use. This can be displayed by selecting the Find & Replace… option from the 
Edit menu whilst viewing coin details: 
 

 
 
This will display the Find & Replace pop-up: 
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For example, the address of a coin dealer, which is mentioned in the Source field, has changed and 
you want the current address in the Source field: 
 

 
 

1. Source Field – the coin Source field 

2. Text To Change – the existing address that needs changing 

3. Empty/non-empty – facility to find empty or non-empty fields as well as specific text 

4. Result Field – the same coin Source field 

5. Text To Change To – the replacement address 

6. Replace/Append – replace existing text or append at end of existing text 

7. Find & Replace – start finding and replacing 
 

In the above example we changed a value within a field.  Alternatively, you might want to move a 
value from 1 field into another.  For example, you might want to remove the coin condition from 
the general Notes field and place it in the Condition Note field: 
 

 
 
Note that the Find & Replace affects only those coins currently displayed in the details screen. 
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6. MENU OPTIONS 
 

The following menus are available in MyCoins-UK: 
 

MyCoins-UK Menu: 

 

 
 

– general info including version number 
 
 
 
 
 

 
– Quit MyCoins-UK 

File Menu: 

 

 
– create new coins collection 
– open existing coins collection 
– save current coins collection to disk 
– create a new coins collection by saving copy of current collection 
– close current coins collection 
– import items from compatible CSV file 
– export subset of coins collection to CSV file & images folder 

– export current table as CSV file (for list and valuation screens) 

– export images at real or magnified size 

– reload & refresh picking lists (list screen only) 

– permanently delete old images 

Edit Menu: 

 

 
 

– standard Cut 
– standard Copy 
– standard Paste 
 

– select all items in List table (list screen only) 
– deselect all items in List table (list screen only) 
 

– open Advanced Search pop-up (list screen only)  
– open Find & Replace pop-up (details screen only) 
 

– resync fields linked to the Year field  (details screen only) 
 

– recalculate Bullion values  (valuations screen only) 

View Menu: 

 

 
 

– expand window (to make it easier to read) 
– shrink window (to make everything visible on a small screen) 
 

– return window to standard size 

Help Menu: 

 

 
 
 
 
– open Calibration screen 
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7. EXPORTING AND IMPORTING 
7.1 Exporting Collections, Tables and Images 

The Export Collection… option from the File menu gives you the opportunity to export the current 
subset selected in the table on the List screen, or the complete collection. An exported collection 
consists of a master file in CSV format (containing everything except images) together with a 
folder with all the related images. 
 
The Export Table… option from the File menu gives you the opportunity to export all the rows 
from the current table in the List or Valuation screens.  A table is exported as a single CSV format 
file with the first row containing the column/field headings. 
 
The Export Images… option from the File menu gives you the opportunity to export the images for 
all the coins currently displayed in the Details screen. You can choose to have the exported images 
at real size or at the magnified size usually displayed by the MyCoins app. 
 

7.2 Importing 

The Import Items… option from the File menu allows you to import everything except images 
from a CSV file.  Note that the CSV file must have the same arrangement of fields/columns as the 
MyCoins-UK master file, although some can be empty (such as the Unique ID field which will be 
generated during the import process). 
 
 
 

8. PRINTING 
Because the main data storage is CSV format, the MyCoins app doesn't include any printing 
facilities as you can use a spreadsheet app for this purpose.  In addition, you can do standard 
screen shots when you want to print the details of a coin. 
 
 

9. NON-BRITISH/WORLD COINS 
Whilst the MyCoins app was developed for cataloguing British coins it can be adjusted for 
cataloguing coins from anywhere. Certain parameters may be altered to make the app more 
appropriate for non-British coins. If you'd like a version for coinage in general (MyCoins-World), 
contact us for details.  A supporting document "MyCoins-World Addendum.pdf" is available to 
give details of the differences between MyCoins-UK and MyCoins-World. 
 
 

10. AVAILABILITY 
The MyCoins app is available free of charge without any warranties, implied or stated. The use of 
MyCoins is entirely at your risk. 
 
The MyCoins app is available for Macs running OS X/macOS (10.10 or later) and PCs running 
Windows 7 or later.  A version for Linux may be made available if requested, but such a version 
may have some reduction in the facilities it provides. 
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11. APPENDIX: FILING SYSTEM 
11.1 Filing System Overview 

The following is a partially expanded overview of the filing system used by MyCoins-UK (where 
[abc] indicates a folder "abc"). 
 
a. The app folder MyCoins-UK, which should be inside your Documents folder or on your Desktop: 
 

[MyCoins-UK] 
 [MyCoins-UK-Data] 
  [support] 
   MyCoins-UK.ini – control/initialisation file 
   [TEMPLATE Collection] 
    [Collection-TEMPLATE] 
     [Images] 
     [Lookups] 
 MyCoins-UK.app – the app itself 

 
b. The collection folder Collection-XYZ, which can be anywhere in your filing system but must be 
named "Collection-…" where … can be anything: 
 

 [Collection-HJR] 
  Collection.csv – main database itself 
  [Images] – coin images related to main database 
   10147~1968~Set - Specimen~obv.jpg – obverse image 
   10147~1968~Set - Specimen~oth~a.jpg – 1st other image 
   10147~1968~Set - Specimen~oth~b.jpg – 2nd other image 
   10147~1968~Set - Specimen~oth~c.jpg – 3rd other image 
   10147~1968~Set - Specimen~rev.jpg – reverse image 
  [Lookups] – picking lists (see below) 
   Bullion.csv 
   Conditions.csv 
   Denominations.csv 
   DenomInfo.csv 
   Materials.csv 
   Monarchs.csv 
   SetCodes.csv 

 
The following is a collapsed view of the filing system layout used by MyCoins-UK: 
 

[MyCoins-UK]  – on Desktop/in Documents 
 [MyCoins-UK-Data] 
 MyCoins-UK.app – the app itself 

 
 [Collection-HJR] – anywhere in the filing system 
 Collection.csv – main database itself 
 [Images] – coin images related to main database 
 [Lookups] – picking lists (see below) 
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11.2 Control/Initialisation File (MyCoins-UK.ini) 

MyCoins-UK uses an INI file (MyCoins-UK.ini) to control its features and behaviour. This file is a 
text file with the following sections: 
 

• Calibration factor – scaling required to display coins at real size 

• Collection Type – UK, Commonwealth, Non-UK coins 

• Destructive Image Deletion – should "deleted" images be deleted or marked as deleted 

• Default Sort Order – sort fields and order 

• Coin Collection Fields – the master database fields in the order they occur 

• Advanced Search facilities – factors to support the advanced search feature 

• Special fields – fields that differ between UK, Commonwealth & Non-UK 

• List Table Columns – fields/columns that are displayed in the coins list screen 

• Filter Fields – fields/columns that are filters in the coins list screen 

• Exported Image Fields – fields added to master database when exporting images 
 
In general, the INI file should not be changed.  However, there are a few items that might be 
changed as a once-off (Calibration factor, Collection Type and Default Sort Order). 
 

11.2.1 Calibration Factor 
This is used to calculate the scaling required to display coins at real size. Typical values are 21mm, 
24mm, 38mm, 41mm, 46mm depending on the physical size and pixel resolution of the screen: 
 

; Calibration factor - real size of dummy coin on screen (in gDiamUnits units) 
gDummyDiag=46 

 

11.2.2 Collection Type 
This makes MyCoins-UK specific to a particular country/currency: 
 

; Collection Type - UK, NonUK: 
gCollectionType=UK 
gDiamUnits=mm 
gCurrency=GBP 
gWeightUnits=g 
gCountry= 
 

11.2.3 Default Sort Order 
This defines the default sort fields and their sort orders for the Coin List: 
 

; Default Sort Order: 
;   sort fields (major to minor sort keys) 
;   order = ascending, descending 
gDefSortField=Year,Denomination,Condition 
gDefSortOrder=ascending,descending,descending 
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11.3 Bullion Values Fields (Bullion.csv) 
 

This gives the approximate bullion prices for precious metals of different purities (31 July 2018): 
 

Material Price Notes: 
– the bullion file is static, you need to update it manually 
– changing the bullion file and refreshing the picking lists (File menu) 

affects new coins, it doesn't change any existing bullion values 
– if you want to update existing bullion values, you must: 

• select the coins to be updated in the List screen, 
• switch to the Valuations screen 
• reload the bullion rates 

Silver-Gold-Plated 0.37 

Gold 0.9166 28.55 

Silver 0.5 0.20 

Silver 0.925 0.37 
Silver 0.999 0.40 

 

11.4 Main Database Fields (Collection.csv) 
 

This is a standard text-based CSV file that can be viewed and edited (with care) using spreadsheet 
apps such as Excel, Numbers, LibreOffice etc. 
  

Field Purpose (if not obvious) 
UniqueID – index key 

Denomination – denominations in face value order, high-to-low 

Year  
YearTo – for coin sets 

SetCode – for grouping into sets (used for Country in non-UK collections) 

Monarch – changed to ObverseDesign for non-UK collections 

Diameter  

Type  
Material  

Weight  
SpinkNo – catalogue number (changed to CatalogueCode for non-UK collections) 

Mintage  

Condition – conditions in quality order, high-to-low 

ConditionNote  

Storage – where the item is stored (e.g. album-2) 
Acquired  

Source  

Paid  
Value  

Bullion – estimated bullion value based on weight of precious metal content 
Duplicates  

DateDisposed  

PriceReceived  

Notes  

 
Note that some characters need to be encoded for MyCoins-UK purposes.  The characters and 
their alternatives (all double characters) are as follows: 
 

• comma – ## 

• double quote – %% 

• tab – ^^ 

• return – @@ 



© 2018 Peter Reid MyCoins-UK/World v0.7, August 2018 Page 28 of 33 

 

For example, the following: 

the "rose" crown, because it has… 
 
would be encoded as: 

the %%rose%% crown## because it has… 

 

11.5 Picking Lists 

MyCoins-UK uses several files to provide picking lists wherever possible since picking lists are 
easier and more consistent than free-text entry. In particular, the following files are used: 
 

• Conditions.csv – common coin condition values 

• Denominations.csv – coin denominations 

• DenomInfo.csv – additional denomination-related information 

• Materials.csv – metals used in each type of coin 

• Monarchs.csv – monarchs with their reigns 

• SetCodes.csv – types of sets of coins 
 
Note that the picking list files are text files which can be edited in order to add or remove options.  
The lists given here are suggestions based on our own coin collecting experience over a number of 
years. You are free to use or change these as necessary to meet with your collecting requirements. 
 

11.5.1 Conditions.csv – standard coin condition terms 
 

Condition Notes (if any) 

UNKNOWN  

FDC (Fleur de Coin) 
BU (Brilliant Uncirculated) 

Unc (Uncirculated) 

AUnc (About/Almost Uncirculated) 

GEF (Good Extremely Fine) 

EF (Extremely Fine) 
NEF (Nearly Extremely Fine) 

GVF (Good Very Fine) 

VF (Very Fine) 
NVF (Nearly Very Fine) 

GF (Good Fine) 

F (Fine) 

NF (Nearly Fine) 

Fair  
Poor  

CD  
 
Note that the conditions are listed in descending order of quality so you can select a range of 
conditions in an Advanced Search. 
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11.5.2 Denominations.csv – 1 entry per unique coin type, index term for DenomInfo.csv 
 

Denomination FaceValue YearRange 
UNKNOWN 0 F 

Hundred Pounds 100 F 
Fifty Pounds 50 F 

Twenty Pounds 20 F 

Five Pounds 5 F 
Silver Bullion 1oz 2 F 

Two Pounds 2 F 

Two Pounds Proof 2 F 

Sovereign 1 F 

Pound 1 F 
Half Sovereign 0.5 F 

Silver Bullion quarter oz 0.5 F 
Fifty Pence 0.5 F 

Crown 0.25 F 
Double Florin 0.2 F 

Twenty Pence 0.2 F 

Halfcrown 0.125 F 
Florin 0.1 F 

Ten Pence 0.1 F 
Five Pence 0.05 F 

Shilling 0.05 F 

Sixpence 0.025 F 
Twopence (2p) 0.02 F 

Groat 0.017 F 

Threepence 0.012 F 

Threepence Brass 0.012 F 

Penny (p) 0.01 F 

Twopence 0.008 F 

Penny 0.004 F 
Model Penny 0.004 F 

Halfpenny 0.002 F 

Halfpenny Token 0.002 F 
Farthing 0.001 F 

Half Farthing 0.0005 F 

Set - Proof 0 F 

Set - BU Year 0 F 

Set - Circulated Year 0 F 
Set - Type 0 T 

Set - Specimen 0 T 
 

Note that the denominations are listed in descending order of face value so you can select a range 
of denominations in an Advanced Search. 
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11.5.3 DenomInfo.csv – 1 entry per coin variant 
 

This file provides additional denomination information based on the coin, the year it was made, 
etc. This gives MyCoins-UK the information needed to display a coin at actual size, to calculate its 
estimated scrap value (based on weight and proportion of precious metal). 
 

Denomination YearFrom YearTo Diameter Material Weight 
Crown 1694 1751 39 Silver 0.925 30 

Crown 1804 1804 41 Silver 0.925 28 

Crown 1818 1836 39 Silver 0.925 28.3 
Crown 1837 1900 39 Silver 0.925 28.2 

Crown 1902 1902 39 Silver 0.925 28.3 

Crown 1927 1946 39 Silver 0.5 28.3 

Crown 1947 1965 39 Cupro-Nickel 28.3 
Crown 1966 1989 39 Cupro-Nickel 28.3 

Double Florin 1887 1890 36 Silver 0.925 22.6 

Farthing 1625 1649 13 Copper  

Farthing 1672 1700 23 Copper 6.2 

Farthing 1714 1714 23 Copper 5.8 

Farthing 1717 1754 23 Copper 5.3 
Farthing 1771 1775 24 Copper 4.9 

Farthing 1799 1799 23.5 Copper 6.3 

Farthing 1806 1807 21 Copper 4.7 

Farthing 1821 1830 22 Copper 4.75 
Farthing 1831 1859 22 Copper 4.7 

Farthing 1860 1901 20 Bronze 2.9 

Farthing 1902 1956 20 Bronze 2.8 
Fifty Pence 1969 1996 30 Cupro-Nickel 13.5 

Fifty Pence 1997  27.3 Cupro-Nickel 8 

Fifty Pounds 2015 2016 34 Silver 0.999 31 

Five Pence 1968 1989 23.6 Cupro-Nickel 5.65 
Five Pence 1990 2011 18 Cupro-Nickel 3.25 

Five Pence 2012  18 Steel-Nickel-Plated 3.25 

Five Pounds 1990 2017 38.61 Cupro-Nickel 28.28 
Florin 1849 1849 28 Silver 0.925 11.3 

Florin 1851 1887 30 Silver 0.925 11.3 

Florin 1888 1901 29.5 Silver 0.925 11.3 

Florin 1902 1919 28.5 Silver 0.925 11.3 
Florin 1920 1946 28.5 Silver 0.5 11.3 

Florin 1947 1967 28.5 Cupro-Nickel 11.5 

Groat 1836 1836 16 Silver 0.925 1.4 
Groat 1838 1888 16 Silver 0.925 1.9 

Halfcrown 1696 1701 33 Silver 0.925 15.1 

Halfcrown 1703 1751 34 Silver 0.925 15 

Halfcrown 1816 1919 32 Silver 0.925 14.1 
Halfcrown 1920 1946 32 Silver 0.5 14.1 

Halfcrown 1947 1967 32 Cupro-Nickel 14.1 

Half Farthing 1828 1859 18 Copper 2.4 

Half Farthing 1860 1901 18 Bronze 2.4 

Halfpenny 1695 1701 29 Copper 11.5 

Halfpenny 1717 1719 25 Copper 10.3 

Halfpenny 1720 1724 27 Copper 10.3 
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Denomination YearFrom YearTo Diameter Material Weight 
Halfpenny 1729 1754 30 Copper 10.3 

Halfpenny 1770 1775 30 Copper 10 

Halfpenny 1799 1799 31 Copper 13 
Halfpenny 1806 1807 29 Copper 9.4 

Halfpenny 1825 1859 28 Copper 9.5 

Halfpenny 1860 1967 26 Bronze 5.7 
Halfpenny Token      

Half Sovereign 1902 2012 19 Gold 0.9166 4 

Hundred Pounds 2015  40 Silver 0.999 62.86 

Model penny 1844 1848 22 Copper-zinc-nickel  

Penny 1698 1795 12 Silver 0.925 0.5 

Penny 1797 1797 36 Copper 28.3 

Penny 1806 1808 34 Copper 18.9 
Penny 1817 1820 11 Silver 0.925 0.5 

Penny 1825 1859 34 Copper 18.8 

Penny 1860 1967 31 Bronze 9.4 

Penny (p) 1971 1991 20.3 Bronze 3.56 
Penny (p) 1992  20.3 Steel-Copper-Plated 3.56 

Pound 1983 2015 22.5 Nickel-Brass 9.5 

Pound 2016  23.43 Nickel-Brass 8.75 
Shilling 1560 1603 31 Silver 0.925 5 

Shilling 1625 1649 29 Silver 0.925 5 

Shilling 1666 1701 26 Silver 0.925 6.2 

Shilling 1702 1763 26 Silver 0.925 6 
Shilling 1787 1798 25 Silver 0.925 6 

Shilling 1816 1919 24 Silver 0.925 5.7 

Shilling 1920 1946 24 Silver 0.5 5.7 
Shilling 1947 1967 24 Cupro-Nickel 5.7 

Silver Bullion 1oz 1987  38.6 Silver 0.999 31.21 

Silver Bullion quarter oz 2014  22 Silver 0.999 7.86 

Sixpence 1561 1600 25 Silver 0.925  

Sixpence 1695 1701 21 Silver 0.925 3.1 

Sixpence 1703 1726 21 Silver 0.925 3 

Sixpence 1728 1758 21 Silver 0.925 3.2 
Sixpence 1787 1787 21 Silver 0.925 3 

Sixpence 1816 1919 19 Silver 0.925 2.8 

Sixpence 1920 1946 19 Silver 0.5 2.8 

Sixpence 1947 1967 19 Cupro-Nickel 2.8 
Sovereign 1817  22 Gold 0.9166 8 

Ten Pence 1968 1992 28.5 Cupro-Nickel 11.3 

Ten Pence 1993 2011 24.5 Cupro-Nickel 6.5 

Ten Pence 2012  24.5 Steel-Nickel-Plated 6.5 

Threepence 1561 1582 20 Silver 0.925 1 

Threepence 1625 1649 20 Silver 0.925 1 

Threepence 1670 1713 18 Silver 0.925 1.5 
Threepence 1717 1800 17 Silver 0.925 1.5 

Threepence 1817 1919 16 Silver 0.925 1.4 

Threepence 1920 1944 16 Silver 0.5 1.4 
Threepence Brass 1937 1967 22 Nickel-Brass 6.8 

Twenty Pence 1982  21.4 Cupro-Nickel 5 

Twenty Pounds 2013  27 Silver 0.999 15.71 
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Denomination YearFrom YearTo Diameter Material Weight 
Twopence 1797 1797 41 Copper 56.7 

Twopence (2p) 1971 1991 25.9 Bronze 7.12 

Twopence (2p) 1992  25.9 Copper-Steel 7.12 
Two Pounds 1986 1996 28.4 Nickel-Brass 15.98 

Two Pounds 1997  28.4 Cu-Ni-Brass 12 

Two Pounds Proof 2003  28 Silver-Gold-Plated 12 

 

11.5.4 Materials.csv – 1 entry per unique material type 
 

Material Elements 

UNKNOWN  
Brass Cu-Zn 

Bronze Cu-(Zn-Sn) 

Copper Cu 
Cupro-Nickel Cu-Ni 

Cu-Ni-Brass Cu-Ni-Zn 
Gold 0.9166 Au 

Nickel-Brass Ni-Cu-Zn 
Nickel-Steel Ni-Fe-C 

Silver 0.5 Ag-Cu-(Ni) 

Silver 0.925 Ag-(Cu) 

Silver 0.999 Ag 

Silver Ag 
Silver-Gold-Plated Ag-(Au) 

Steel-Copper-Plated Fe-(Cu-Mn-C) 

Steel-Nickel-Plated Fe-(Ni- Mn-C) 

MIXTURE  
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11.5.5 Monarchs.csv – 1 entry per monarch 
 

This provides a list of Monarchs or Obverse Designs covering the periods your coins were made.  
The year of the coin is used to look up any reigning monarch at that time. 
 

Monarch ReignStart ReignEnd ReignYears 
UNKNOWN    
Anne 1702 1714 13 
Charles I 1625 1649 25 
Charles II 1660 1685 26 
Commonwealth 1649 1660 12 
Edward VI 1547 1553 7 
Edward VII 1902 1910 10 
Elizabeth I 1558 1603 46 
Elizabeth II 1953  64 
George I 1715 1727 14 
George II 1728 1760 34 
George III 1761 1820 61 
George IV 1821 1830 11 
George V 1911 1936 27 
George VI 1937 1952 17 
Henry VIII 1509 1547 39 
James I 1603 1625 23 
James II 1685 1688 4 
Mary I 1553 1558 6 
Victoria 1838 1901 64 
William III 1689 1701 14 
William IV 1831 1837 8 
VARIOUS    

 

11.5.6 SetCodes.csv – 1 entry per unique type of set 
 

This allows you to group similar items as sets.   You can add as many set codes as required and you 
can remove any that aren't required. 
 

SetCode Notes 
N/A  
Commemorative Crowns  
Farthing Types  
Farthings (year range)  
Fifty Pence Types  
Florin Types  
Halfcrown Types  
Halfpenny Types  
Halfpennies (year range)  
Penny Types  
Pennies (year range)  
Pound Types  
Shilling Types  
Shillings (year range)  
Sixpence Types  
Sixpences (year range)  
Threepence Types  
Threepences (year range)  
Year Set  
UNKNOWN  
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